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Many email filters automatically block messages that look suspect. Please make sure your 
email system and Inbox are setup to accept emails from BIDSHelp@cttso.gov as this is the 
email address BIDS uses to notify you of the results of your submission. Regardless, it is 
always advisable to login and check your dashboard every few weeks for updates.

BIDS no longer transmits questions or 
directions via email. This type of data is now 
stored and viewable on your submission. 
Always check for this information in BIDS 
before submitting a follow-on proposal.

Homepage
The homepage offers several areas of interest to submitters. Check the 
BIDS Advisory Announcements section for information about BAAs and 
other news items.

New Registrations
A registration is required to respond to a BAA.

Logging in to BIDS
To login to BIDS, select the 
Submitter link on the homepage. 
Enter your Username and Password, 
then click the Login button

•	 From the Homepage, select the New to BIDS link.

•	 �Click the “Vendor” image on the left hand side of the pop-up 
window.

RSS Feed - BIDS has a Really Simple Syndication (RSS) news feed you 
can set up to automatically receive BIDS notices. See our Online Help 
section for directions.

General BIDS Help
Help links are available to all users on any BIDS page.

Online Help provides a link to the following help types:

•	 FAQs – A list of Frequently Asked Questions to our Help Desk.

•	 �Help? – A list of documents that explain how to do most things in 
BIDS.

•	 �BAA Questions – A list of questions and answers to queries about 
specific requirements under a BAA.

•	 �Search Results – Displays documents related to the term you type 
in the search box.

Request Help allows users to send questions directly to the Help Desk 
Staff when they can’t find an answer in the Online Help section.

View or Download BAA
To obtain a copy of current BAAs, look under “BAA Information” in the 
middle left hand side of the homepage to find a link to recent “BAA 
Packages.” 

Double click any link to open the file in your browser or right-click a link to 
save the file locally on your computer.

Your browser must be configured to allow pop-ups for BIDS to 
work properly. Also, please disable any third party pop-up blockers.

Do not reregister if a valid account exists and submissions are 
pending evaluation.

You do not have to be registered or logged into BIDS to read our BAAs or 
Request Help.

Registrations are automatically approved, but may take a few minutes 
to be processed. Please be patient and wait for your conformation email 
before attempting to login.

NEW

•	 �Complete all mandatory fields (marked  *). 

•	 �User Names must be unique to the site and contain no spaces or 
special characters.

•	 �Your registration’s point of contact should reflect your organization’s 
contract authority.

•	 �Account integrity is critical to the solicitation process. Email is the 
only method of communication allowed between the Government 
Contracting Officer and submitters. Be sure to maintain the correct 
information in your BIDS registration.

•	 �Business type information is used for general statistical data 
collection only. To ensure accurate analysis and consideration in 
special programs current information is requested. 

•	 �Click Submit Registration and make sure the success message 
displays.
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Uploading a Submission
Before you begin, review Tips and Hints for Success (see back page.) 
Know the location of the file to upload. Check the file name and size 
before starting a submission.

•	 Active BAAs will be listed under Upload to a BAA.

•	 Click any BAA shown to get a list of its requirements.

•	 To start the submission process, click any Requirement of interest.

•	 �Review the checklist, then click Continue once you have 
everything ready.

•	 Complete the required fields in the submission form.

•	 Use Choose File to select your submission document.

•	 Click Submit Proposal once the form is filled out.

•	 �Confirm your submission is now listed under Past Proposals on 
your homepage.

Checking Submission Progress
•	 Login to BIDS, and look under the Past Proposals section.

Removing a Submission from Consideration
Submissions can only be removed from consideration before the BAA 
closing date or before a follow-on submission due date.

•	 Login to BIDS, and look under the Past Proposals section.

•	 Select any submission with the status Pending Evaluation. 

•	 Open it and then click Delete Proposal.

•	 Click to confirm you want to delete the submission.

•	 �Confirm your submission is no longer listed under Past Proposals 
on your homepage.

Uploading a Follow-On Submission
For each follow-on phase, submitters are prompted at first login to 
confirm and update the registration information. Once the update is 
done, you will be taken to the submitter homepage.

The Proposals Due section will show all follow-on submissions we have 
requested from you.

•	 Click any of the links to open a submission.

•	 Click Create Next Proposal.

•	 �Review the checklist, then click Continue once you have 
everything ready.

•	 Complete the required fields in the submission form.

•	 Use Choose File to select your submission document(s).

•	 Click Submit Proposal once the form is filled out.

•	 �Confirm your submission is now listed under Past Proposals on 
your homepage.

No Bid Guidance
When a follow-on submission is not planned for upload by the submitter, 
a notice in BIDS is required. Provide a letter (attachment) as the next 
submission upload, indicating the submission has been removed from 
further consideration. 

•	 Each submission’s status in the review process is listed.

•	 �You can open any submission to review it, but cannot change 
anything if the due date is past. 

 SUBMITTING TO A BAA REQUIREMENT

Shot-gunning, or uploading a submission to every requirements is 
not good practice and is strongly discouraged.

Modifying a Submission
Make all edits or correction to the submission document on your local 
computer.

•	 Login to BIDS and look under Past Proposals.

•	 Select the submission you want an open it by clicking on it.

•	 Click Edit Proposal.

•	 Click the trashcan icon and confirm you want to delete your old file.

•	 Click Choose File and upload the new file. 

•	 Click Submit Proposal.

Changes to uploaded responses are permitted up to the closing date and 
time. Changes after closing or due dates are not permitted.
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Quad Charts
Quad charts are a single page, divided into four quadrants and provide the 
essence of the proposed solution for a specific requirement.

Additional Help with Submissions
Be sure to follow the guidance provided in the BAA package when 
creating submissions. 

Other explanations and templates are available both in the Reference 
Materials and Online Help sections of the website.

Mandatory BAA Closing Date and Time
Every BAA will specify a closing date and time. Times are always in the 
current Eastern Time zone. 

A submission is not considered complete until the Submit Proposal 
button on the form is clicked. This button does not become click-able until 
all required fields are filled in and the required file(s) are uploaded. 

You may change a submission up to the time the BAA closes. Therefore, 
be sure to register, login and upload submission early.  

The system monitors all user actions and late submissions will not be 
accepted.

Updating Contact Information
It is important that the Contact information on your account is kept up to 
date. To change your information login to the account. (Use the Forgot 
Password? feature if necessary.)

•	 �On the left hand side of the page, under “Helpful Links” select 
Edit My Account.

•	 Verify and edit contact information as needed.

•	 Click Submit Registration.

To view the sample Quad Chart, 

•	 Click the “Reference Materials” link on the BIDS Homepage.

•	 �Scroll down to the section “Document Format” and click “Quad 
Chart Sample.”

Evaluation Criteria
Submissions are evaluated according to individual merit and relevance 
to program requirement rather than against other proposals. Evaluation 
criteria highlights from the BAA package are:

Basic Requirement

•	 �Proposed solution meets the stated requirement.

•	 �Proposal exhibits comprehensive understanding of the problem 
and the requirements of intended users.

•	 �Multiple users. (U.S. Government or Commercial)

Cost

•	 �Achievable, reasonable, and complete for work proposed.

•	 �Costs analyzed and risks addressed.

•	 �Cost sharing and any other agency funding is documented.

Schedule

•	 �Achievable and reasonable for work proposed.

•	 �Risk and critical elements addressed.

Technical Performance

•	 �Approach is feasible, achievable and complete.

•	 Technical team has expertise and experience.

•	 Effort defined, complete and in a logical sequence.

•	 �Deliverables and products clearly defined and will meet the 
requirement.

•	 Technical risks and mitigation defined, feasible, and reasonable.

•	 �Government Furnished Equipment and materials are identified 
with needed dates.

•	 Intellectual property ownership addressed.

•	 Transition plan to production addressed.

Past Performance

•	 Success in similar efforts.

•	 �Demonstrated ability to deliver products within budget and 
schedule.

•	 �Team has demonstrated expertise in the technical area 
proposed, and in cost, schedule, and risk management.

Requirements to Receive Government Funding
To make a submission, vendors only need to register in the BIDS 
system.

In order to be awarded a contract, however, a vendor must register 
with the Government. There is no cost for these registrations. To find 
out what you may need:

•	 On the homepage find the section labeled “Helpful Links.”

•	 �Click the link Prerequirements for Working with the 
Government.

•	 �Follow the directions for obtaining a DUNS number and 
registering in SAM.
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OTHER BAA INFORMATION EVALUATION CRITERIA

Use the sample quad chart found in the Reference Materials section as 
guidance. Refer to the BAA package for all content requirements.

The information in the BAA package trumps all other instructions.

Quad charts do not require a cover page.

All submissions must follow the instructions in the published BAA 
package. Include all specified information to avoid disqualification 
or delays in evaluation. Always refer to the published BAA package 
for the most up-to-date guidance.
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TIPS AND HINTS FOR SUCCESS

Document Identifier
Each submission is assigned a unique document identifier by the BIDS 
system. The number has four parts. The first two parts are the Mission 
Area and Requirement number (resp.) the submission was made against. 
The third part is the Submitter’s BIDS User Name and the fourth part is 
the Submitter Internal Tracking Number (SIT#)

This number is generated upon completion of the submission process. 
An example might look like:

TOS-R3678-XYZCorp-QC1

Submitter Internal Tracking Number (SIT#)
This number, chosen by the submitter, allows them to uniquely identify 
their proposals. This is especially important if they are submitting more 
than one solution to a BAA or Requirement. This number may contain up 
to 24 alphanumeric characters, hyphens, or underscores.

Vendors uploading a single submission can use simple text such as “QC” 
or “WP” as their SIT#. 

Vendors uploading multiple submissions should use the number 
generated by their company’s proposal tracking system, or any 
numbering system that allows them to track multiple initial and follow on 
submissions. For example: 

Submission Type Suggested SIT#
Quad Charts QC1, QC2, QC3, …

White Papers WP1, WP2, WP3, …

Full Proposals FP1, FP2, FP3, …

The SIT# forms part of the Document Identifier which BIDS uses to track 
all submissions.

File Naming 
File attachment names shall consist of alphanumeric characters, hyphens 
and underscores only. Special characters are not allowed. You must 
correct any file names before beginning the upload process.

Secure Public Access 
Uploading a submission from public computers such as those at home or 
public libraries is permissible. Be sure to clear your browser cache when 
done. See below for directions to clear your cache.

Internet Explorer

•	 �From the Tools menu, select “Safety” then “Delete browsing 
history.” 

•	 Select all boxes and then click “Delete.”

Google Chrome

•	 �Left click the menu located in the upper right hand corner of the 
browser.

•	 �Select “History” and recent tabs then click the “Clear browsing 
data” button.

•	 Select how far back you want to clear the data and check all boxes.

•	 Click “Clear browsing data”

Merely editing the file name in the Attachment field on the 
submission form will result in a submission record with no file 
attachment.

Never enter or attach classified data in BIDS.

Apple users must have the entire file name and path free of 
special characters and spaces.

Restrictive Marking on Proposals
Vendors should clearly indicate content disclosure limitations on all 
submissions. Markings can appear as “Proprietary”, or words to that 
effect; however,  do not use “Company Confidential” or other phrases 
that could be confused with national security classifications.

Procedure for Classified Submittals
When responding with a classified proposal, the submitter must first 
create a “place holder” submission in the BIDS system. Attach only the 
cover page (which should contain an unclassified summary). Indicate 
in the Comments area that the proposal could not be uploaded due to 
classification.

Format and File Size Limits
Acceptable document formats and file types are specified in the BAA 
package. The most common file types are Microsoft Word, PowerPoint 
and Excel, as well as Adobe Acrobat. File size limits explained in the BAA. 
Suggestions to reduce file sizes are found below and in the  
Online Help section of BIDS.

Tips to Reduce File Size
Graphical Images in General

•	 Crop unnecessary borders or unused space.

•	 Resave the image as a JPEG, GIF, or other compressed format.

Microsoft PowerPoint

•	 Select a graphical image in the file.

•	 Click the “Picture Tools” menu on the “Format” tab.

•	 In the Adjust group select “Compress Pictures.”

•	 �In the Compress Picture frame, click “Apply to selected pictures 
only” if you don’t want all pictures compressed.

•	 Click OK.

Adobe Acrobat

•	 From the File menu, select “Save As”

•	 Select “Optimized PDF” and click OK

•	 Select a new location, enter a file name, and then click Save

Remember, the resolution must be clear enough to print and view the 
final document on screen.

BIDS Email Notifications
The BIDS system is designed to send a notification email to submitters 
when a decision made on their submissions. Please remember that 
these emails are a courtesy.  All submitters are required to check the 
status of their submissions intermittently by logging into the system and 
checking their “Past Proposals” from their homepage.

Also, changes to email spam filters have caused a number of these 
notifications to be deleted by the submitter’s email system before they 
reach their mailbox. Please ask your mail administrators to allow emails 
from BIDSHelp@cttso.gov. 

Next, the submission must be marked, packaged, and mailed in 
accordance with handling requirements for the level of classification. 
Vendors must include the BIDS Document Identifier in the header of the 
mailed submission.

Remember, classified submission must be received by CTTSO before 
the BAA submission period ends. Classification does not eliminate the 
requirement to comply with all BAA Instructions. You should refer to the 
BAA package for more information regarding classified submittals.


